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MBP Overview
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Optimization

Data Display
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MBP Overview

Model Builder Program (MBP) is a model extraction tool that provides a turnkey 
solution for parameter extraction and model generation. MBP has an open interface 
that allows you to customize modeling flows and internal functions using scripting. 
It's core environment includes all the necessary components for data loading, 
model simulation, parameter extraction, model generation and reporting. It is a 
complete solution that integrates SPICE simulation, parameter extraction, 
optimization, and model generation.

MBP supports all advanced models and mainstreamed simulators and enables the 
engineers to check models acquired from foundries directly.

MBP provides:

Turnkey statistical modeling flow that enables data dispose, fast simulation, 
global statistical and local mismatch model generation in a dedicated 
module

Equation viewer to view the details of complex equations and debug models 
as parameter(s) varies

Model comparison function that enables in-progress model comparison 
during model extraction process

Error monitor giving a global view of fitting error

Model extraction packages for high-voltage, SOI, Multi-gate FinFET, 
Statistical and mismatch, and SPICE library construction

Powerful tweaking function to re-target model library according to the 
design specifications

It includes Equation Viewer, High-Voltage Device Modeling package, Smart Model 
Retargeting module, and the automated extraction solutions for the latest CMC 
approved models such as PSP. In addition, it has many built-in features such as 
Error Monitor, Corner Model, and Lib Parser that improves the usability and ease 
the model extraction process.

MBP Design Environment

MBP Files

Device Navigation

Device Navigation

This section describes the operation of MBP's device navigator. It includes the 
following topics:

Device Navigator Interface

Graphic Device Selection (G-select)

Device Roller

Operation of Device Navigator
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Device Navigator Interface

The Device Navigator is located in the left side of main MBP window. It is designed 
to track all device information. once you load a valid measurement data file, the 
device navigator window pops up as shown in following figure.

Device Navigation Window

The table on the top side lists device information. An important property of device 
is device index. In the example above, the device of 10/0.15 has index of 6. You can 
select or deselect device by checking or unchecking the status box of each row.

Let us use BSIM3v3 model as an example, by default, MBP outputs W, L, and T in 
device navigator. Click  icon  to select/unselect the instance Edit Instance
parameters from the table, as shown in following figure.

Edit instance

To edit model instance and the corresponding device instance, click Extraction > 
 from the main menu, the pop-up window is shown in following Instance Setting

figure.
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Instance setting

A sample device table with all parsed instance parameters in is shown in following 
figure.

Device Navigator with all instance parameters

The Page window is decked at the bottom of the device navigator window. It refers 
to certain device characteristics. In the measurement data file, there can be many 
devices and each device in turn can have several device characteristics. We call 
each characteristic a page. For example, in Bsim3v3 MOS measurement, typically 
there are four pages:
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Page 1: Ids vs. Vgs @ Vds = 0.1V (or 0.05V) with different Vbs.

Page 2: Ids vs. Vgs @ Vds = Vdd with different Vbs. (Vdd is the maximum 
drain voltage).

Page 3: Ids vs. Vds @ Vbs = 0V with different Vgs.

Page 4: Ids vs. Vds @ Vbs = Vbb with different Vgs. (Vbb is the maximum 
body bias).

The  button shows all the characteristics of the highlighted device. And All Pages
the  button shows the highlighted device characteristic of all the All Devices
selected devices. Once the  option is checked, only the pages of the Same Device
highlighted device are displayed. As for which pages of the highlighted device gets 
displayed, it depends on whether you choose to show  or merely the All pages
highlighted device characteristic. This function is mainly to facilitate observation of 
all the characteristics of each device from one to another.

In the upper left corner of each plot, there is a plot index in the format of device 
. For example, as shown in following figure, the plot has an index index - page index

of "4-3", it means that it is the third plot (Ids vs. Vds @ Vbs = 0V with different Vgs) 
of the device with index of 4 (W/L=10/2 T=25C).

Sample MBP plot

Another useful function is that in the table window, you can sort the devices 
according to the index, W, L, T or any other instance parameters by clicking the 
title row of the table. It gets sorted in either descending or ascending order. As 
illustrated in following figure, devices are in ascending order to W. It helps you to 
select devices with the same width, length, or temperature. You can also select 
devices in a graphic mode which is described in Graphic Device Selection (G-select)
section.

Devices sorting according to W
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Devices sorting according to W

By clicking icon  near , you can minimize the Device Navigator to a bar. Page
The operation remains the same, with acknowledgement of every button, as shown 
in following figure. To be noticed, in this case, device scroll plays a role of switching 
between devices. Correspondingly, page scroll plays a role of switching between 
pages.

Minimized Device Navigator
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Graphic Device Selection (G_Select)

MBP offers to select devices in a graphic mode. Click  on device navigator, G_Sel
the graphic selection window pops up as shown in following figure. View the device 
selection on the graph. You can zoom in on the graph by drawing rectangle 
covering the selected region. To return the original scale, double click on the 
graph. You can also change the scale of both X and Y axis by double clicking the 
two axes. To select a device, hold  and use cursor (press and hold the left Ctrl
button) to draw a square to include the desired points. You can clear all the 
selections by clicking the  button. After the selection is done, press  or Clear Apply

.OK

If loaded data are with two or more temperatures, switch between devices with 
different temperatures through  column at the left. And any operation is to the T
devices under highlighted temperature.

Graphic Selection Window

Device Roller

Device roller is a device selector which performs most of functions as the Device 
Navigator. Since it is at the bottom of each plot, you can browse different devices 
and pages without leaving the plot. The function that each button performs is 
explained as following:

 : All pages are replaced by the corresponding ones All Previous Device
(with the same page index) of previous device.

 : Current page (active window, see  section Previous Device Active window
for details) is replaced by the page (with the same page index) of previous 
device.
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 : Current page is replaced by the page selected from the Select Device
device list, as shown in .Figure: Clicking Select device

 : Current page (active window, see  section for Next Device Active window
details) is replaced by the page (with the same page index) of next device.

 : All pages are replaced by the corresponding ones (with All Next Device
the same page index) of next device.

By device roller, you can only browse the devices that already selected in the 
Device Navigator.

The switching sequence through device roller follows the same sequence in the 
Device Navigator. For example, if the device is sorted by W (channel width), this 
order is also applied in device roller. If no device is available for the  or next previous

, when you point the cursor to the device roller, it turns red, like icon  .

If math functions (like dx/dy) or scale transform (like x-lin, y-log) are applied to 
the current plot, such settings are kept when you switch between devices and 
pages by the device roller.

Clicking Select device

Operation of Device Navigator

In this section, we are introducing the definitions and settings regarding to the 
operation of Device Navigation.

Active Window

Clicking any of the plot window makes it , which means it reflects the change active
made on the device navigator. If you want to display the certain page of certain 
device in a window, you should make the window  first (by clicking the plot), active
then use the device navigator to locate the desired device and page. In the sample 
window shown in following figure, the upper right window (i.e. index 6-2) is  active
with the title bar brightened.

Sample Active window
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Sample Active window

Next/Previous Screen

When multiple devices are selected, once clicked  or  button, All Devices All Pages
MBP often could not display all the plots in one screen. Then icon  gets Next Screen
activated. You can use the  or  buttons highlighted in Next Screen Previous Screen
following figure to switch between screens. For both  and , All Devices All Pages
MBP arranges plots in the order the same to that in Device Navigator. You can look 
through pages with desired order by sorting in Device Navigator.

Switching Between Devices

Layout Configuration
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Layout Configuration

In GUI, select  to access layout configurations. By default, MBP Tool > Layout
displays four graph panels. If you want to display other styles of the plot window, 
select the configuration of the plot from the list as shown in following figure.

Graph Option Window

Or customize layout definition by clicking . The layout menu setup Customize
window gets displayed and you can create new layout freely, shown in following 
figure.

Layout setup Window

MBP Design Environment

This chapter describes the MBP GUI provided by MBP. It covers the following 
topics:
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Main Window View

The Main window appears after MBP program starts, as shown in Figure: Main 
. It consists of six major parts:window view of MBP

Status Bar

Displays the path and name of the current project, compatible simulator and model 
information.

Main Menu

The central control part of MBP. It comprises eleven menus. Each of them has its 
own drop down sub-menu.

Tool Bar

Provides an easy way to carry out MBP's functions.

Control Pane

Device Navigator enables you to access and manage measurement data in data-
based MBP. The data are listed in the format of tables in control pane. Other 
modules including Task Tree, IMV pages, and Lib Parser are also organized in tree 
structure in this pane. Switch among modules by clicking the corresponding tags.

The tags besides  are only available after corresponding Device Navigator
modules are activated. For example, after you click  icon in the tool Task Tree
bar, you can see the  tag at the bottom of control pane.Task Tree

Control pane can be docked by clicking the  icon  in the tool bar.Hide Left Pane

Plot Panel

All plots are displayed in the plot panel. If none of page is selected, the pane 
remains empty.

Bottom Pane

It contains two switchable windows:

Message window: You can read the information such as the executed 
operation, error information, etc., from the Message window. Switch to this 
window by clicking the  tab.Message

Parameters window: All the parameters available are listed in the left and 
the selected parameters for tuning are listed in the right. For more 
information about parameter window, see . Bottom Defining Parameters

pane can be docked by clicking the  icon  in the tool Hide Bottom Pane
bar.
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Main window view of MBP

Plot Operations and Options

You can view the data using plot options like zoom in/out on the plot, set data 
range, change scale, etc. For more details on plotting operations and options, see 

 section.Data Display

Other GUI Options

Layout Config

Using Layout tools, you can configure the way device pages are displayed. For 
more information on Layout tool, see  section.Layout config

Data Reader

Data Reader can be used to determine the XY coordinates of a data point on a plot. 
For more information on data reader, see  section.Data Reader

For details on other GUI tools, see  section.Data Display

MBP Files

This chapter describes the file management in MBP. It includes the following 
topics:

Overview

Project Files

Measurement Files
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Model Files

Files under etc

Files under usr

Files under defaultproject

File recentpath

Overview

Model extraction process involves many files including HSPICE/SPECTRE models, 
device characterization results, and system setting files. You can save, load, edit, or 
retrieve these files during modeling process. To give a clear expression of MBP files 
organization, a tree structure as well as the descriptions is shown in following 
figure.
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Tree structure of MBP files

$MBP_Home stands for the directory where MBP has been installed.
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File recentpath

MBP shows your latest file (as shown in following figure) when you load data, 
model, or project. All the history records are saved in the file . recentpath.ini

Clear this file after long time's usage since, there may be too many records here.

Quick Combo Box

You can delete the unnecessary lines in this file to make the quick combo box 
clean.

Files under defaultproject

The configuration files regarding RF and statistical are stored under the folder 
\defaultproject.

\defaultproject\rf

There are several subdirectories under \defaultproject\rf which represent for 
different device types. All the model types supported by RF module are included in 
here. They can also be viewed by clicking  from the main Model > Select Model >RF
menu, as shown in following figure.
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RF module supported model type

\defaultproject\statistical

Similar with RF, there are also several subdirectories under 
\defaultproject\statistical which represent for different device types. They can also 
be viewed by clicking  from the main menu, as Model > Select Model > Statistical
shown in following figure.
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Files under etc

From this section, the customizable files, including the configuration files for many 
MBP features settings are introduced. There are many configuration files in its 
directory structure. These files define the display property, files operating paths, 
and so on. The modifications in these files customizes the tool as per your 
requirements. Files ending with *** in title can be modified in GUI. It is also 
recommended to modify the files in GUI directly. However, in some particular 
cases, it might be required to edit these files instead.

First we introduce the files under \etc directory. An example of directory structure 
is shown in following figure. The directory structure under \etc folder is complex. 
However, the hierarchy of this folder is straight-forward. Different simulator type is 
the first level while device type is the next. Under the model level folder, there are 
three folders named inst_core, model_core, and options, respectively.
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Files in \etc\hspice\mosfet\bsim3v3\model_core

default_nmos.ini (or default_pmos.ini)

This file defines the default value of the parameters, soft/hard boundary, and the 
sweep step for the model corresponding. If model card is not used to define the 
parameter value, MBP takes the default value from this file. The default value is 
identical with the default value which BSIM3V3 defines. When a parameter is out of 
the default hard boundary, MBP prompts the warning message.

The hard boundary of the parameters could be only modified in this file.

The syntax of definitions is shown below:
Syntax:
Parameter_name = {para_type; defaultvalue; soft_boundary; hard_boundary; step}
Example:
lmin = {type=0; default=10E-6; soft=[1e-8,1e-4]; hard=(0,inf); step=1e-7}

model_nmos.l (or model_pmos.l)
When creating a new project in MBP, this model file is loaded by default. 
The parameters in this model file can be a subclass of those in default_nmos.
ini (or default_pmos.ini) .

paramclassify.conf

By configuring both parameter classification file (paramclassify.conf) and model 
settings file(default_nmos.ini), you can organize the parameters in the optimization 
window. The usage of parameter classification files is shown in following figure.
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Usage of parameter classification file

Besides the files introduced above, there are also two optional configuration files ( 
 and  ) enables you to customize model parameters. To param.ini paramclass.ini

realize this function, create these two files in the corresponding  . The examples \etc
of these two files are shown below. You can define parameters name, boundary, 
group, etc there.

param.ini

[Test]
 
*** P  ***
  p1        =  {type = 0;   default = 1;            
soft = [ 0,          10 ];         hard = [ 0,          
10 ];           step = 1              }
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  p2        =  {type = 0;   default = 1;            
soft = [ 0,          10 ];         hard = [ 0,          
10 ];           step = 1              }
  p3        =  {type = 0;   default = 1;            
soft = [ 0,          10 ];         hard = [ 0,          
10 ];           step = 1              }
  p4        =  {type = 0;   default = 1;            
soft = [ 0,          10 ];         hard = [ 0,          
10 ];           step = 1              }
 
*** q ***
  q1        =  {type = 0;   default = 2;            
soft = [ 0,          10 ];         hard = [ 0,          
10 ];           step = 1            }
  q2        =  {type = 0;   default = 2;            
soft = [ 0,          10 ];         hard = [ 0,          
10 ];           step = 1            }
*  *paramclass.ini* 
 
[demo1]
  value = 1
  [demo2]
value = 2

So, after the following lines are added in the model file:

.param
+p1=0 p2=1 p3=2 p4=3
+q1=0 q2=0 q3=0

The model card window in MBP appears as shown in following figure.

User-defined parameters in group

Files in \etc\Hspice\MOSFET\BSIM3v3\inst_core

inst.ini

This file claims the model name and instance parameter of the certain device. MBP 
creates netlist according to this file. Modify this file to add the instance parameters.
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Syntax:
Model_name, ports name, device type, instanceparameter1=<default_value, 
parameter_type, unit_scale, offset_value, unit_name>;
Example:
m1 d g s b nmos w=<1e-6,W,1e-6,0,um> l=<1e-6,L,1e-6,0,um> temp=<25,T,1,0,>;

In some cases, you can use instance parameters with different names. For example, 
you can define subcircuit model as:
mcore d g s b width=1e-6 length=1e-6

To make it compatible to MBP, change model definition to fit its format:
mcore d g s b w=1e-6 l=1e-6

or add the definition to inst.ini as:
...w=<1e-6,width,1e-6,0,um > l=<1e-6,length,1e-6,0,um>...

instdisplay.ini

This file records the instance parameters that displayed on the device navigator, 

which is the top left corner. Click the button   to add or delete the Edit Instance
instance parameters displayed. The Instance Parameter window is shown in 
following figure.

If option  in the Edit Instance window is checked, the file name of the File
measurement data is displayed in a new column. Hence, you can easily 
separate the data from different files by name.

meainst.ini

The file meainst.ini is only applied to the old measurement module which is 
stopped being developed now. Since, DCP has replaced the old measurement 
module, refer to DCP user manual ($MBP_HOME\dcp\doc) for more powerful 
and flexible feathers.
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Different from the file inst.ini, file meainst.ini defines the instance parameters that is 
recorded during the measurement. The basic syntax is just the same as inst.ini. The 
Measurement Instance Parameters window is shown in following figure.

\etc\hspice\mosra

The folder includes the setting files regarding MOSRA. The file \etc\hspice\config.
ini lists the device type which MOSRA supported: mosfet and soi.

\etc\analysis.xml

The file analysis.xml is critical to the simulations and outputs. After loading the 
measurement data, MBP establishes the netlist according to its counterpart in 
analysis.xml and passes the netlist to internal or external engine. In summary, it 
works as a bridge between the measurement data and the outputs of MBP.

The analysis.xml is divided into several sections. Each section corresponds to a 
certain device type. Let's use the bjt section in the file analysis.xml for instance, as 
shown figure below. First we get variable declarations. After name is declared, 
decide its source type. The "i" stands for current source and "v" stands for voltage 
source. And the sweep mode should be either 'dc' or 'cv'. The  or  tonode fromnode
determines how you connect this source, or say that it determines the polarity. 
Then all these variables are allowed for reference in the page declaration.
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Analysis

In the page declaration, ensure that circuit name should match the page name 
properly, as in the following. The  represents reference node for this circuit. ground
Here, "ib" and "ic" are the outputs. In terms of the element items, describe the 
connection of the sources to the available nodes.

<circuit name=  type=  ground= >Ic_Vbe dc e
<output name=  unit= />ib a
<output name=  unit= />ic a
<element name=  type= />vbe v
<nodes=  def_value= />b,e 0
<element name=  type= />vbc v
<nodes=  def_value= />b,c 0
<element name=  type= />vse v
<nodes=  def_value= />s,e 0
<circuit/>

The corresponding output is illustrated below in following figure.



29 Using MBP

Analysisoutput

\etc\parameter.ini

Default value for process parameters is saved in this file. For each section, the 
syntax is as shown below:
entry_name = entry_value

Here, the  is model parameter name. And the  is surrounded entry_name entry_value
by <> and comma-separated to five parts.

Take Tox for example,
Tox=<70.0,Tox,1e-10,0,A>

In the order from left to right, means: 70.0(default value), Tox(GUI display string),1e-
10(scale),0(offset value),A(unit symbol)

You can modify the parameter value by clicking , shown Model-> Set Model Options
in Figure 2.21. The detailed items in the window are different for different models 
types such as HSPICE_Bsim3, HSPICE_GP etc.

Model_option
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1.  

a.  

b.  

c.  

d.  

e.  

1.  

2.  

3.  

a.  

b.  

c.  

d.  

e.  

If the value of process parameter defined in model card is different from the 
default, MBP chooses the value from the model card. In other word, the 
parameter value defined in model card has a higher priority than the default.

\etc\graph.ini

This file defines the default plot style. There are four sections here: The first section 
is for plot type definition; the second section defines the scale of x-axis; the third 
part saves the y-axis scale; and the last one records the math-transform 
information. Detail information is shown in the following:

Syntax:

PageName=GraphStyle, XLogScale, YLogScale, MathTransform

graph style: 0 for CARTESIAN.(Default=0)

for Smith Chart

for Polar Chart

for STAC_HISTOGRAM

for STAC_SCATTERPLOT

for MISMATCH

X-axis log scaled: true/false (Default=false)

Y-axis log scaled: true/false (Default=false)

math transform code: 0 for Y_AXIS_VALUE_RAW (y)(Default=0)

for Y_AXIS_VALUE_RECIPROCAL (1/y)

for Y_AXIS_VALUE_FIRST_ORDER_DERIVATIVE (dy/dx)

for Y_AXIS_VALUE_SECOND_ORDER_DERIVATIVE (y*)

for Y_AXIS_VALUE_THIRD_ORDER_DERIVATIVE (y*')

for Y_AXIS_VALUE_FIRST_ORDER_DERIVATIVE_ PECIPROCAL (dx/dy)

For example:

[BJT]
Ic_Vbe=0,false,true,0
Ie_Vbc=0,false,true,0
Beta_Ic=0,true,false,0

\etc\paramconvert.xml

MBP supports model loading from HSPICE and SPECTRE format. The parameter 
conversion mapping is saved in this file. The configuration in the file and the 
corresponding comments are shown below:

<Hspice> //The original SPICE format, to be  converted 
from.    
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<to_Spectre>// The target SPICE format, to be converted 
to.        
<MOSFET> // Device Type.            
<allModels> // for all model types under 
MOSFET.                
<Delete/> // parameters to be deleted.                
<Exchange/> // paramaters to have name 
exchanged.                
<DeleteByValue/> // parameters to be deleted in case of 
specified  value.                
<ExchangeNameAndValue/> //parameters to have name 
exchanged in  case of specified value.            
</allModels>            
<BSIM3V3/>//for BSIM3V3 model.            
<BSIM4/>//for BSIM4  model.        
<BJT/>        
<DIODE/>    
</to_spectre></Hspice>

\etc\modelconf.xml

MBP supports different model types. For each type, MBP allows you to define 
different versions. The configuration in the file and the corresponding comments 
are shown below:

<device name=*mosfet*> // Define MOSFET   
<simulator name=*hspice*> // Define HSPICE format    
<condition> // condition of HSPICE MOSFET    
<and>   
<or>   
<polar value=*nmos*/> // nmos and pmos    
<polar value=*pmos*/>   
</or>   
<not>   
<or>   
<parameter name=*level* value=*57* type=*double*/> // 
Not SOI devices    
<parameter name=*level* value=*70* type=*double*/>   
</or>   
</not>   
</and>   
</condition>   
</simulator> 

<model name=*bsim3v3*> // Under MOSFET HSPICE, define 
Bsim3v3 model type    
<simulator name=*hspice*>   
<condition>   
<or>   
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<parameter name=*level* value=*49* type=*double*/> // 
Bsim3 level    
<parameter name=*level* value=*53* type=*double*/>   
</or>   
</condition>   
</model>

\etc\rfgraph.ini

The RF module in MBP supports smith chart and polar chart dealing with the S/Y/H
/Z parameters. The plot property is defined in this file as well as in GUI. You can 
also modify it in GUI (shown in Figure 2.22) by clicking Tool > GUI options > RF 

.Graph Config

The structure of rfgraph.ini is as following:

[S param]
Smith Chart=1,-1,-1,1
Polar=0,1,1,0
Re-Freq=0,0,0,0

The syntax is:

plot_format=flag_s11, flag_s12, flag_s21, flag_s22

where flag_sxx can equal to , , .  means it is not plotted,  means reversely, 0 1 -1 0 1
and  means that this chart is not selectable.-1

Make sure that one RF model is selected first to enable the  RF Graph Config
option in the main menu.

Files under usr

Under this folder, there exist the files which define many MBP features, such as IMV 
pages, Task tree, Error monitor, etc.
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Files under \jef\usr\hvtemplate

You can create or load their own HV templates here. The folder's structure is the 
same as the tree structure in subckt template. One example is shown in following 
figure.

Template Tree Structure

You can create as many levels of directories as wanted. However there should 
have four files in the last level of the directory: The two model files 
(model_nmos.l and model_pmos.l) are necessary for MOSFET while two JPEG 
files (which for the effect and schematic) are optional.*

Refer to the Subcircuit Template section in  for the steps to create Utilities
templates in MBP.

Files under \jef\usr\rftemplate

Same as HV templates described above. This folder is also fully customizable so 
you can add your own RF model formats easily.

Files under \jef\usr\math

This folder contains the math-transform functions. Adding these functions needs 
programming knowledge on JAVA.

Files under \jef\usr\target

Files under this directory are for error monitor usage. There are three files in 
default. The file rule.index contains the activate rule files list. And the criteria rules 
are recorded in rule files mos.rule and soi.rule. The rule file syntax is shown as 
below:

\[Title\]
  value:vth0\(mv\)

http://edadocs.software.keysight.com/display/mbp2017/Utilities
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  \[Definition\]
  value:Vth@vbs=0
  \[Target_type\]
  value:vth
  \[Enabled\]
  value:yes
  \[Warning_criteria\]
  value:0.03
  \[IsAbsolute\]
  value:yes
  \[Scale\]
  value:1000
  \[Range\]
  index:1
  page:Ids_Vgs_Vbs\|Vds=Vdlin   pvalue:0 
............................

Each rule contains eight fields, they are: [Title], [Definition], [Target_type], 
[Enabled], [Warning_criteria], [IsAbsolute], [Scale] and [Range] .

In the field of [Title], specify target name. Avoid using the same title for different 
target.

[Definition] section defines tips displayed on screen tp help clarify target definition. 
It gets displayed if pointed to the corresponding rule, the corresponding GUI 
window in this example is shown in following figure.

Target Title and Tips

[Target_type] section defines the target value in particular rules. It should be set as 
one of the following:

A variable like Vth or Idsat

RMS

MAXRMS

[Enabled] section enables certain target in error monitor by setting the value to yes. 
Otherwise this target is not displayed on the error monitor screen.

[Warning_criteria] section defines the criteria value of the target. MBP uses red 
color (by default) to plot this target if its value exceeds the criteria. If a variable is 
set as [Target_type], the [Warning_criteria] could be either absolute value or 
relative value, depending on how [IsAbsolute] is set.

[IsAbsolute] section defines if this value is an absolute value or a relative (ratio) 
value, like RMS.
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[Scale] section is for unit control. For example, the default unit of Vth is Voltage. If 
the scale value is set to 1000, then, MBP displays Vth in mV as unit. 
(1mV*1000=1V) However, it does not affect the values in [Warning_criteria].

[Range] section is to select particular page to get the target value. You can define 
the page name, certain region in page or even the curve with certain P value in the 
pages. It contains several keywords as following:

Index: An integer value. More than one index for a rule means that it can be 
applied under different conditions.

Page: To select one of available device pages.

Pindex: An integer value. To identify which curves to select, use "," to 
separate different curves, like "0,1,4". All curves are selected by default.

Pvalue: To specify which curve to select. However, it could uses built-in 
variable, like "0,VBB". By default, all curves are selected.

Mathfunction: Choose one of these math functions: "y", "1/y", "y' ", "y" ", "dx
/dy". Math function defaults to "y".

XRegion: To specify x-axis region on selected page. By default, it is (-inf, inf). 
You can also use other variables. For example: (vth, vth+0.2)

YRegion: To specify y-axis region on selected page. By default, it is (-inf, inf). 
Another example: (-inf, 0.8*ymax)

The following lists the variables you can refer in the rule, some rules have been 
discussed already:

VGG: max VGS

VDD: max Vds

VBB: max Vbs

VDLIN: minor Vds used in Ids_Vgs_Vbs page

Vth: subthreshold voltage

Idsat: saturation drain current

Xmin: the min x value

Xmax: the max x value

Ymin: the min y value

Ymax: the max y value

-inf: the negative infinite value

inf: the positive infinite value.

Multiple regions are supported by adding multi-range section with different 
Index values. * *For detailed information on how to customize the error monitor, 
please refer to the Error Monitor section in .Utilities

http://edadocs.software.keysight.com/display/mbp2017/Utilities
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Files under \jef\usr\tasks

The files regarding task tree are placed here. You can customize the task tree by 
clicking  from the main menu, as shown in following figure. Extraction > Task Tree
The interface of Task Tree can be seen as a tab besides the Device Navigator.

Files under \jef\usr\extras

The two folders ( \ and ) in this directory are both for the analysis mete\r
measurement related operations. Folder \ is for the target definition. There analysis
are many files for different curves such as , , Cgd_Vds_Vgs.class Ids_Vds_Vgs.class
etc. in this folder. Similarly, measurement instruments can be added in the folder 

. Provide necessary documents (such as programming manual) if new meter
instrument is required to be supported in MBP.

Files under \jef\usr\imv

IMV stands for intermediate variable. Under this directory, all the configuration files 
regarding IMV pages are stored on the basis of device type. Taking mosfet as 
example, there are seven files under <MBP HOME>\jet\usr\imv\device\mosfet.

algorithm.ini

File  defines the algorithm for imv target calculation. It is used for algorithm.ini
target calculation method definition, an example is shown below.



37 Using MBP

1.  

2.  

3.  

4.  

5.  

6.  

7.  

[GM] _name=GM
algorithm=acc/Derivative
parameter=(vgs,ids)
pagename</em><em>=Ids_Vgs_Vbs_

name defines the name of the algorithm.

algorithm defines the method to obtain the target.

acc/Derivative is its internal function for derivative calculation.

parameter specifies what parameters to use in the calculation. In this 
example, Ids, and Vgs is used.

pagename defines which pages are used in the calculation. Ids_Vgs_Vbs is 
used in the example.

There are seven internal functions available in MBP. All these functions are related 
to the curves (or points) chosen by the restrictions (  ) from Imv_target_def.ini
selected page (  ). A list of internal functions is shown below:algorithm.ini

(acc/Current) Get the Y-axis value.

(acc/CurrentDivideW) Similar to 1 and normalized by W.

(acc/CurrentMultiplyL) Similar to 1 and normalized by 1/L.

(acc/CurrentDivedeWL) Similar to 1 and normalized by W*L.

(acc/CurrentDivdeWMultiplyL) Similar to 1 and normalized by W/L.

(acc/Derivative) Get the derivative value.

(acc/GMax) Get the maximum value of gm. *Notice: All the names of these 
functions are case sensitive.

cal_target_def.ini

File  defines the target of imv calculator and the default parameter cal_target_def.ini
sweep.

dp_target_def.ini

File  defines the target especially for DP data.dp_target_def.ini

imv_const.ini

File  defines the imv constants value, such as Vgg, Vdd.imv_const.ini

imv_graph.ini defines the plot of imv pages.

File  specifies the contents to plot in MBP.imv_graph.ini
[Plot_Name]
X-axis definition
P-axis definition
Y-axis definition
Hierarchy setup

When plotting expression targets, parameter should be specified to certain 
items of the expression, e.g. x=vbs/Idsat
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imv_target_def.ini defines the imv target, including the algorithm used and 
parameter restrictions.

After defining the algorithm of the targets, configure file  to define imv_target_def.ini
what is used in the plot. There are three kinds of applications in this file:

#the first application:
#refer to other targets, by name
[vth]
name=vth
refer=vth_gm,vth_con,vth_con_LogId
current=vth_gm

You can choose to use vth_gm, vth_con or vth_con_LogId using options on GUI.

#the second application:
#expression of other targets, by name
[vth1]
name=vth1
exp=vth_gm+vth_con

By this way, MBP can calculate certain targets using existing values and simple 
calculation functions. All the existing targets and the parameters in restrictions 
could be used for expression.

#the third kind of application:
#define a target, with algorithm and its restrictions
[vth_gm]
name=vth_gm
algor=vth_gm
restrictions=(device,absmax(vds),absmin(vbs))

This indicates that vth_gm value is from vth_gm method in algorithm and it is a 
saturation threshold voltage (with the maximum vds and minimum vbs).

target_graph.ini

File  defines the plot especially for DP data.target_graph.ini

For more information about how to customize IMV, refer to IMV Pages and DP 
.Implementation

Measurement Files

Measurement files include two types: Measurement Setup Files and Measurement 
Data Files.

Measurement Setup Files

Since, DCP has replaced the old measurement module which is stopped being 
developed now. The content in this section is obsolete and kept here only for 
the users using the old version of MBP. New users can refer to DCP user 
manual ($MBP_HOME\dcp\doc) for more powerful and flexible feathers.

http://edadocs.software.keysight.com/display/mbp2017/IMV+Pages+and+DP+Implementation
http://edadocs.software.keysight.com/display/mbp2017/IMV+Pages+and+DP+Implementation
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Measurement Setup files are to store measurement instrument information and 
bias conditions. By default, the measurement setup files have the extension of .conf
. An example of the Measurement Setup window is shown in following figure. The 
first label page contains instruments information and node assignments. And the 
other label pages are bias configurations. Correspondingly, measurement setup 
files are also consisting of two types of files: the instrument setup file and the 
analysis setup files.

Measurement Setup window

For the analysis setup files, each analysis has its own setup file. As illustrated in 
, bias condition of analysis Ids_Vgs_Vbs is Figure: Saved Measurement Setup files

put into file Ids_Vgs_Vbs_NMOS.conf. To save the setup, you can either save all the 
setup (instrument setup and analysis setup) to one file by clicking  in Save All

 or save the setup to separated files by clicking Figure: Measurement Setup window
. Similarly, when to load setup, you can either load all measurement Save Setup

setup files or just one of setup files into measurements.

Saved Measurement Setup files

Measurement Data Files

Measurement data files are used to store measurement data. By default, the 
measurement data files have the extension of ".mea". You can open and edited the 
same using text editor. MBP supports various data types (such as DC, Mismatch, 
RF, Statistical, etc.). It is described in the following section.

DC Data File

An example of DC data is shown below:



Using MBP 40

condition {mode=forward,type=nmos,modtype=DC} 
Page (name=ids_vgs_vps,x=vgs,p=vps,y=ids)  {vds=1.0,ves=
0.0,W=0.18,L=0.15,T=27.0 }
curve { 0.5 }
0.0     1.1024053054394643E-10
0.05     3.2827790989388004E-10
0.1     1.223897310845409E-9 
0.15     4.802207520961346E-9 
0.2     1.8552352100490592E-8 
0.25     6.847457189856461E-8
0.3     2.3744388358213807E-7
0.35     7.582069804395346E-7
0.4     2.1063300093137126E-6
0.45     4.785803862526468E-6
0.5     8.884813678495436E-6 
...... 

The first line of the data file contains the information of working mode, device type, 
and voltage mode. From the example above we know the nmos device is in forward 
working mode and under DC analysis.

The second line defines all page related information. The information within round 
bracket  contains Page Name, X variable, P variable and Y variable. The ( )
information within brace  declares Page Constant including bias condition, device { }
geometry.

The latter is the data block information. We know that each page may contain 
several curves with different P values. For every curve block, it always begins with 
key word  and the corresponding P value. All data points are then listed curve
behind it. The first column is for X variable and the second column is for Y variable, 
separated by either  or . Other delimiters are not recognized. The example space TAB
data plot is shown in following figure.
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Content of measurement data file and corresponding page

The page name and variables are defined in the file analysis.xml under <MBP 
. See section  for more details.HOEM>\etc \etc\analysis.xml

Mismatch Data File

MBP supports two kinds of data formats for mismatch. The first one is base on the 
actual measurement data. And the second one allows you to input the mean and 
sigma value of the target. It is introduced in the following section. Below is an 
example of the first one:

miscondition{date=,type=NMOS}
  Page (name=vth_gm,target=vth_gm,scale=1.0,p=(L,W)) 
{vds=0.1,Vgs=1,Vbs=0,icon=1E-7,T=25}
  {0.18,2.0}
  0.002604200182343308    0.015163779612074824    -0.001
6386308204789923    0.0012339958926110839    0.008895426
625025848    -0.0048731228537369775    -0.01162406783793
8012       
  -0.006426794909106914    0.003820585385617581    -0.00
3906291053092925    -0.005558806143440509    0.003262499
108588224    -0.004310905700422363    -0.004533647758578
008    
  -0.005645149082360135    0.005513986383539615    -0.00
12684190995226885    -0.004787090185292664    -0.0136843
2377987483    0.0055176400252267    0.023908953534973687
  -0.0031491340681994995 -0.004776220049452662    -0.010
298545804177328 ..........................
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The first line of the data file begins with the keyword <em>  and miscondition</em>
contains the information of time and device type.

The second line defines all page related information. The information within round 
bracket  contains Page Name, target, scale, and P variable. The information ( )
within brace  declares Page Constants including bias/current condition and { }
temperature.

The latter is the data block information. For every curve block, it always begins with 
{L W} . All data points are then listed behind it. They are the vth difference between 
two adjacent devices with the same geometry (in this example it's the device of L=0.
18 and W=2.0). The example data plot is shown in Figure Mismatch data graph

Mismatch data graph

You can also choose the other format for the mismatch data, the example is shown 

below:

condition\{corner = tt,date = oct_20_02\}   Datatype\
{mismatch\}   Version\{1.0\}   type\{nmos\}   Delimiter\
{,\}   Instance\{L, W, T\}    Input\{vds=0.05, Vgs=1, 
Vbs=\-1,icon=1e\-7\}   Targets\{Ids\}      Data\{ 
L,     W,    T,     vds,    vgs,    vbs, ids\}   40,    
5,    25,    0.05,    3,    0,    0,    6.448e\-4   40, 
2,    25,    0.05,    3,    0,    0,    9.836e\-4   30, 
2,    25,    0.05,    3,    0,    0,    9.6235e\-4   20,
2,    25,    0.05,    3,    0,    0,    1.28e\-3   20,  
1,    25,    0.05,    3,    0,    0,    1.889e\-3   20, 
0.5,    25,    0.05,    3,    0,    0,    2.448e\-3   6,
1,    25,    0.05,    3,    0,    0,    3.4727e\-3   10,
0.5,    25,    0.05,    3,    0,    0,    3.503e\-3   6,
0.5,    25,    0.05,    3,    0,    0,    4.1108e\-3 
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In this format, the first part of the data file contains the information such as corner 
type, time, data type, device type, instance, bias condition, and target.

The second part of the data file includes the data block information. The first line 
begins with the keyword Data following the variables. All data are then listed from 
the second line. It is noted that the last two values in every line are corresponding 
to the mean and the sigma of the target. In this example, * 40, 5, 25, 0.05, 3, 0, 0, 
6.448e-4* means *L=40um, W=5um, T=25C, Vds=0.05V, Vgs=3V, Vbs=0, Ids(mean) 
=0, and Ids(sigma)=6.448e-4A* .

MOSRA Data File

An example of MOSRA data file is shown below:

condition{corner = tt,date = oct_20_02,instrument=
(hp4145, probe_station\),mode=forward,datatype= mosra, 
version=1.0, type=nmos}
  Page (name=ids_vgs_vbs,x=vgs,p=vbs,y=ids\) { vds=0.05,
w=10.0,L=0.13,T=25.0\}stress( time=0.0,vds=2.0,vgs=1.0,
vbs=0.0)
  curve { 0.0 }
  0.0     5.0002933308273624E-14 
  0.05     5.0016786281530424E-14 
  0.1     5.00960618552065E-14 
  0.15     5.054972647299803E-14 
  0.2     5.3145867705084785E-14 
  0.25     6.800237337193422E-14 
  0.3     1.5301686407243485E-13 

The first line of the data file contains the information of corner type, time, 
measurement instrument, working mode, data type, model version, and device 
type.

The second line defines all page related information. The information within round 
bracket  contains Page Name, X variable, P variable, and Y variable. The ( )
information within brace  declares Page Constants including bias, geometry, and { }
temperature. Finally the keyword stress contains the information such as time and 
bias conditions which applied in the aging test.

The latter is the data block information. For every curve block, it always begins with 
key word  and the corresponding P value (in this example it's the stress time). curve
All data points are then listed behind it. There are two values in every line: the first 
is the value of X variable (Vgs) and the second is the value of Y variable (Ids). The 
example data plot is shown in Figure Mosra_data

Mosra_data
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RF Data File

An example of RF data file is shown below:

[General]
  Datatype:rf
  Version:1.0
  Operator:
  Date:
  Lot:
  Wafer:
  Die:-1,0
  Tile:label 0
  Device-type:mosfet
  Type:nmos
  Nodes:
  Instances:w=32,l=0.25,nf=8,ad=2e-11,as=5e-11,pd=5e-5,
ps=5e-5
  Temperature:27
  Process:
  Ports:g,d
  Z0:50

[Measurement Condition]
  DataName:S\-parameter
  Measurement-condition:S-parameter
  Biasing-type:S-parameter
  Biases:vgs,Vbs,Vds
  rfoutputs:S
  dcoutputs:
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[DC Data]

[RF Data]
  {Vds=0,vgs=0,Vbs=0,x=freq}
  1.0E8,    0.999983,    -0.005338426,    1.184265E-5,  
0.002201805,    1.184264E-5,    0.002201805,    0.999982
,    -0.005427228
  4.98E8,    0.999585,    -0.0265799,    2.935445E-4,   
0.0109595,    2.935442E-4,    0.0109595,    0.99956,    
-0.0270204
  8.96E8,    0.998659,    -0.0477995,    9.494757E-4,   
0.0196952,    9.494748E-4,    0.0196952,    0.998578,   
-0.0485849

There are four modules in above data file.

[General] Define the general information such as device type, instance, 
temperature, etc.

[Measurement Condition] From the above example we know that it's an S-
parameter data file.

[DC Data] It's optional in the rf data file. In the example above there is no DC 
data available.  RF_Data

Statistical Data File

Similar with mismatch, there are also two kinds of data formats for statistical. The 
first one is base on the actual measurement data. And, the second one allows you 
to input the mean and sigma value of the target. It is introduced in the following 
section. Below is an example of the first one:

staccondition{mode=forward,type=nmos}
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    Page (name=Ids,target={Ids(vds=0.05,vgs=1.1\)},
p=vbs){w=0.18,L=0.15,T=25}
    curve0.0}
    site1        1.863622E-5
    site2        1.859326E-5
    site3        1.826478E-5
    site4        1.79857E-5
    site5        1.857634E-5
    site6        1.89573E-5
    site7        1.831234E-5
    site8        1.895472E-5
    site9        1.901374E-5
  site10        1.882349E-5

The first line of the data file begins with the keyword staccondition and contains the 
information of working mode and device type. From the example described earlier, 
we know that it is an nmos device in forward working mode.

The second line defines all page related information. The information within round 
bracket  contains Page Name, target, and P variable. The information within ( )
brace  declares Page Constant including geometry and temperature.{ }

The latter is the data block information. For every curve block, it always begins with 
key word  and the corresponding P value(Vbs in this example). All data curve
information is then listed behind it. There are two values in every line: the site 
number and the target value(Ids in this example). The example data plot is shown in 
Figure statistical_data.

Statistical_data

You can also choose the other format for the statistical data, the example is shown 

below:
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condition\{corner = tt,date = oct_20_02\}     
Datatype\{statistical\}     
Version\{1.0\}     
type\{nmos\}     
Delimiter\{,\}     
Instance\{L, W, T\}      
Input\{vds=0.05, Vgs=1, Vbs=\-1,icon=1e\-7\}    
 Targets\{Vth_gm,Idsat\}          
Data\{ L,     W,    T,   vds,  vgs,vbs, ids\} 0.6,  0.27
  ,      25 , 5.5,  5.5 , 0, 1.94e\-4, 2.44e\-6 0.6,  10
  , 25 , 5.5,  5.5 , 0, 1.94e\-4, 2.44e\-6    
(code} 
 

Data{ L, W,T,vds,vgs,vbs, vth_gm} 0.6, 0.27 , 25 , 5.5, 5.5 , 0, 0.83, 8.95e-3 0.6, 10 , 
25 , 5.5, 5.5 , 0, 0.83, 8.95e-3

In this format, the first part of the  data file 
contains the information such as corner type, time, 
data type, device type,  instance, bias condition, and 
target.   
The second part of the data file includes the data 
block information. Every block  begins with the keyword 
*<em>Data</em>* following the variables. All data are 
then listed from the second line. It's noted the last 
two values in every line are corresponding to the mean 
and the sigma of the target. In this example, 

0.6, 0.27 , 25 , 5.5, 5.5 , 0, 1.94e-4, 2.44e-6

 means *L=0.6um,  W=0.27um  , T=25C , Vds=5.5V,  Vgs=5.
5V , Vbs=0, Ids\(mean\)=1.94e\-4A, Ids\(sigma\)=2.44e\-
6A*

.

Verilog-A Data File

An example of Verilog-A data file is shown below.

condition\{corner = tt,date = oct_20_02,instrument=\
(hp4145, probe_station\),mode=forward,type=nmos}
Page (name=ids_vgs_vbs, x=vgs,p=vbs, y=ids) { vds= .05 ,
w=1.000,L=10.000,T=25.000  } 
curve { 0 }
0            1.08E-12
.05          4.64E-12
.1           2.07E-11
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.15          9.195E-11

.2           4.0652E-10

.25          1.7173E-09

.3           6.374E-09

.35          1.9707E-08

.4           4.7926E-08

.45          9.3226E-08

.5           1.5256E-07

The first line of the data file contains the information of corner type, time, 
measurement instrument, working mode and device type.
The second line defines all page related information. The information within round 
bracket  contains Page Name, X variable, P variable and Y variable. The ( )
information within brace  declares Page Constant including bias condition, { }
geometry and temperature.
The latter is the data block information. For every curve block, it always begins with 
key word  and the corresponding P value (Vbs in this example). All data points curve
are then listed behind it. There are two values in every line: the first is the value of X 
variable (Vgs in the example) and the second is the value of Y variable (Ids in this 
example). The example data plot is shown in following figure.

Verilog-A data graph

DP Data File

An example of DP data file is shown below.

condition{corner = tt,date = oct_20_02,instrument=
(hp4145, probe_station),mode=forward\}
    Datatype{target}
    Version{2.0}
    type{nmos}
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    Delimiter{,}
    Instance{L, W, T} 
  Input{Vgg=1, Vdd=1, Vbb=-1,Vdlin=0.05} 

Data{ w, l, t, vth3, vth5 , Ion5, Ion3, Idh, Idl, 
Ieff,   Imid,  Ioff5, IoffS,  Ib5, Ig5, Ig3, gm, gds}
    10 ,  0.08  ,  25 , 0.651553  ,   0.588125 , 287.850
499,     94.820691     ,       259.189359 ,   2.38974E-1
 ,   2.05312E-1  ,   0.171649   ,     1.606672E-7 
,      5.966716E-8,          -1.010000E-7,              
0  ,                   0,            4.946742E-5   
,        1.308196E-6 
    10 ,  0.15 ,  25  , 0.502278  ,   0.447852,  323.444
683,       84.189907   ,      296.491487,     5.705158  
,    5.097868  ,     4.490579 ,       3.325582E-6,      
3.224582E-6,          -1.010000E-7 ,             0 
,                    0  ,          9.845651E-4   
,        2.416751E-5 
    10 ,  0.24 ,  25  , 0.424177  ,   0.374332,  293.543
081,       65.367928   ,      270.459102,     15.541956 
,    14.333136 ,     13.124317,       2.324948E-5 
,      2.314848E-5,          -1.010000E-7,              
0 ,                    0  ,          2.065517E-3   
,        4.888236E-5 
    10 ,  1    ,  25  , 0.309192  ,   0.267681,  124.335
006,       20.776761   ,      114.883828,     15.649011 
,    14.901380 ,     14.153749,       1.978629E-4,      
1.977619E-4,         -1.010000E-7,              0 
,                    0  ,          1.244241E-3   
,        3.083130E-5 
    10 ,  10   ,  25  , 2.71819E-1,   0.233881,  15.0942
13 ,       2.258570    ,      13.892741  ,    2.181672  
,    2.102561   ,    2.023449 ,       6.146755E-5,      
6.136655E-5,          -1.010000E-7,              0 
,                    0 ,           1.532806E-4  
,         3.245076E-6 

The first part of the data file contains the information such as corner type, time, 
measurement instrument, working mode, data type, device type, instance and bias 
condition.
The second part of the data file includes the data block information. The keyword 
Data defines the instance names(w,l,t) and the page names (v

 th3, vth5 , Ion5.....\)

. All data are then listed from the second line. There are total 18 values in every line 
in the sequence defined in the first line:
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w, l, t, vth3, vth5 , Ion5, Ion3, Idh, Idl, Ieff, Imid, 
Ioff5, IoffS, Ib5, Ig5, Ig3, gm, gds

.

The example data plot is shown in Figure dp_data

dp_data

The data files generated by MBP may comprise multiple devices, depending on whether 

single or a series of devices are taken in the measurement.

Before loading a measurement data file, specify the model type first. If the data file 

doesn't match current model type, loading is disabled. To choose proper model type, click 

. It pops up as shown in following figure.Model > Select Model

SelectModel_new
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Virtual Measurement Data Files

Virtual data is also one of the measurement data file. They have the same format, 
except all the values in the virtual data file are set to zero or identical to the 
simulation values from certain model. Since, simulation in MBP is based on 
measurement data, this file enables you to run simulation at desired bias and 
geometry conditions. To know how to generate virtual data, please refer to Utility.

Model Files

MBP fully supports HSPICE and Spectre models. You can load existing HSPICE (or 
Spectre) compatible model into MBP or export the model parameters in MBP to a 
model file. Again, specify proper model type before loading an existing model. To 
load a model, click , and select the desired model card File > Model > Load Model
from the file browser window.

To export the extracted model parameters into a SPICE model, click File > Model > 
, and specify the model name and the model directory, then click Save Save

MBP also enables you to convert HSPICE compatible model/lib to Spectre 
compatible model/lib directly, by clicking , shown in Export > Export to Spectre
figure Convert below.
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Convert

Project Files

The project files store system and program operation information. You can retrieve 
measurement and model by loading a project.

A new project can be created by clicking  from the main menu File > Project > New
in GUI. You can load the previously saved projects by clicking . File > Project > Open
The pop-up window is shown in . MBP also provides a Figure: Open Project Window
convenient feature to find the project files previously loaded easily. Click File > 

, the recent opened project list should appear there.Project > Reopen

To save the current project, click  or  File > Project > Save File > Project > Save as...
to save as a different project name. The project files are saved in ASCII format, 
which allows you to read the content of the projects.

Open Project Window
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Project file only keeps the links to measurement data. If you have moved data 
away from original site, MBP fails to read in the measurement data with project 
loading. However, for the model, MBP first checks the link. Even it is empty, 
MBP outputs last saved model to the project. Remember to save the model file 
after tuning in such case, since, the model is recorded in the project file instead 
of corresponding to an existing model file.
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Parameters

Defining Parameters

Editing Parameters

Locking Parameters

Parameter Equation Editor

Synchronizing Parameters

Defining Parameters

Using Optimization Window

MBP integrates parameter window and equalizer together. By default, optimization 
window is located in the bottom pane. You can also float the window by double-
click the  tab. Sample optimization windows in both fixed and floating Parameters
status are shown in following figure.

Fixed and Floating Optimization Window

In a model file, some parameters may not be specified. Place the cursor on the 
 so that the double arrow cursor appears. Click and drag Unspecified Parameters

the cursor upward, all unspecified parameters (except partial bin parameters for 
BSIM3v3 and BSIM4) are visible, as show in following figure. Click and drag any 
unspecified parameter to parameter window, then you can assign the value. You 
can also right-click on the parameter window and add parameters through Append
/Insert option.

Show unspecified parameters
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Parameter Selection and Group Selection in Optimization Window

The parameter window organizes the parameters in submenus. The parameter 
classification routine could be found in the file paramclassify.conf (refer to MBP 

 for more details). MBP provides search and autofill functions to find the Files
parameter desired. Type parameter name in the  bar, and the corresponding Search
parameter gets highlighted in the parameter window. To select the highlighted 
parameter to perform optimization, press the  key or click on the parameter. A Enter
sample parameter window with k1, k2, k3, and k3b selected is shown in following 
figure.

Parameter Window

In addition, auto fill function lists all matched parameters in the Search drop down 
box. You can click one directly or use the Down arrow key to highlight one, then 
press the  key, shown in following figure. MBP also supports wildcard *** and Enter ?
, for example, you can type such as * , *  to search the parameters.l vt?0

Auto fill function
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Correspondingly, there are three methods to deselect parameters:

Uncheck parameter box in the table.

Click parameter name, hold the left button and drag it back to the list.

Click  icon to deselect all the parameters.Delete All

A useful function, Group Selection is worth mentioning here. During optimization, 
to fit certain target data, one often chooses certain group of parameters. MBP 
provides easy way to select model parameters in groups. For example, in the 
floating optimization window, select parameters Vth0, K1 and K2, and press the 

arrow button  to unfold Group Selection Window as illustrated in Figure: Select 

. Click the  icon  at the bottom and input the name as parameters in groups Add
vth (user-defined), then vth is added to the Group Selection Window. And 
whenever you double-clicks on , parameters of Vth0, K1 and K2 gets selected vth

from the table. Click the  icon  beneath the window to remove the Remove
highlighted Group Selection from the list.

User-defined Group Selection is available to all projects with the same model 
type.
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Select parameters in groups

Editing Parameters

Following operations can be performed on parameters: , , , , , Add Remove L W P Set 
, , ,  and .Default Enable Hard Boundary Parametrize De-Parametrize Comment

Operation Description

Add To add new parameters to the table, fill all the items in the pop-up window before pressing OK button, as shown in 
following figure.
Add a new parameter as follows:
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Operation Description

Remove To remove the highlighted parameters from both the table and model file.

L, W, P Only if highlighted parameter is binnable, this option becomes available.Left click on L/W/P inserts corresponding partial 
bin parameter to the model. For example, select  and click ,  gets inserted.Vth0 L lvth0

Set Default To reset the parameter to its default value.

Enable 
Hard 
Boundary

Click to enable hard boundary

Parametrize To parametrize the parameters. It only can be used for the Non-binnable and Bin-core parameters.

De-
parametrize

To remove parametrize.

Comments To activate new window named  as follows:Parameter Guide
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Operation Description

The added parameter must be  to the simulator. You can find all supported legal
parameters (except some bin parameters of MOS model) in model settings files 
described in *.MBP Files

If you want to adjust the parameter value, upper and lower boundary etc, double-
click the parameter name to pop up the parameter adjustment window as shown in 
[Figure: Parameter adjustment window|#paramadjwin}. A more convenient way of 

adjusting parameter boundary is clicking  icon  and Expansion Back the 

 icon  . You can specify the scale for expansion by percent. And the expansion
default value is 50%.
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1.  

2.  

3.  

Parameter adjustment window

The values for ,  and  should be always in Upper Value Lower
descending order.

Model parameter may have alias. MBP gives warning message if 
parameters that are already in model file are added.

You can also click the right arrow  and the left arrow  under each parameter 
name to adjust the parameter value. Another easy-to-use way of tuning parameter 

is by simply moving the bar  corresponding to the parameter.

There are three modes available:

Fast commit mode: Both the parameter value and the simulation curve 
response immediately when dragging the bar.

Slow commit mode: Only the parameter value responses immediately when 
dragging the bar. The simulation curve only changes only after releasing the 
mouse.

Manual commit mode: Only the parameter value responses immediately 
when dragging the bar. The simulation curve does not show any change. 
These three modes can be switched in order by clicking the icon highlighted 
in following figure. In the example,  means it's in the Fast commit mode F
now.

Switching between Fast/Slow/Manual modes
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Also, you can edit parameter from the parameter table. As illustrated in following 
figure, double-click on the value of K2, and type the new value. And if this value 
exceeds upper or lower boundary, MBP adjusts its boundary automatically.

Input parameter value directly

In MBP, some flag parameters like  in BSIM3v3 model could not be capmod
CHECKED or SELECTED from the table. You can only specify their values by 
directly inputting the value, as described above.

Locking Parameters

This function is used to keep parameter value unchanged during the optimization. 
To achieve the same, click the  icon as shown in following figure. The lock
background color of the icon turns to red after this action.

Lock parameter

Parameter Equation Editor

Right click on parameter to tune – Equation Parameters – Enable the tweak items 
of equation:
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When select the parameter, all the enabled items will be shown and ready for tune.

If the equation parameters are not enabled, the selection of parameter will still 
show delta value as before

Synchronizing Parameters

This function is used to keep two parameters synchronizing during the optimization. 
Choose the parameters expected to be synchronized first. After clicking 

 icon in the optimization window (shown in Synchronize parameters Figure: 
), a new window (shown in Synchronize parameter Figure: Synchronize parameter 

) pops up to show all the synchronizing parameters.window

Synchronize parameter

Synchronize parameter window
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Add the new synchronization, and then check on the box in front of the equation to 
enable it. If the two parameters are not equal before the synchronization, a warning 
window pops up. You can choose which parameter value to used as current value 
for the two parameters, as shown in following figure.

Synchronize parameter warning window



Using MBP 64

Simulation

Invoking External Simulators

Invoking External Simulators

With its internal engine, you can simulate most of macro and compact models with 
good efficiency and speed. MBP also provides an option to call other simulators for 
verification. You can invoke external simulators by clicking  Simulation > Simulator
from the main menu. There are total four external simulators supported by MBP so 
far: HSPICE from Synopsys, Spectre from Cadence, SPICE3 from UCB, and ADS 
from Keysight.

You can configure the external simulators by choosing Simulation > External SPICE 
 from the main menu. The pop up window is shown in following figure.Options

External SPICE options
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Optimization

Optimization Process

Optimization Utilities and Options

Optimization Process

Optimization is one of the most important steps in model extraction. Besides target 
parameters, it involves the selection on the device, region, and curve for the 
optimization.

Optimization Region Selection

To select region for optimization, select device first. You can use device navigator 
to pick up target devices as described in .Device Navigation

Select Single Region for Optimization

MBP allows you to select data points from either single device or multiple devices 
for optimization. You can press and hold  key and use cursor to draw a Ctrl
designated rectangle as the optimization region. The mark of the data points within 
the region becomes solid square to be differentiated from unselected data points. 
In addition, once a region is selected, the RMS and MAX values under plot are 
updated immediately to reflect the fitting error between simulation and 
measurement in the selected region. As shown in following figure, the original RMS 
and MAX are 1.645% and 3.332%. However, in the selected region, they become to 
2.119% and 3.218%, respectively.
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RMS and MAX values

 

Map Selected Region

If you want to perform optimization to one group of devices with the same 
optimization region, you can either do it one by one manually or right click on the 
plot and select , as shown in following figure. This Map Selected Region > All
operation marks the selected region of current device  to all the devices duplicate
selected in the Device Navigator.
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Map Region Selection

The  is to  the relative location of selected region to all Map Selected Region map
other plots, but not to  the absolute XY coordinates, as illustrated in following map
figure. There are two options for mapping:  maps the region to all selected All
devices in the Device Navigator; and  option allows you to specify the G_Select
target devices.

Obtained regions after map region selection
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Select Multiple Region

MBP also allows selection of multiple regions on the same plot. Turn on this option 
by clicking  from the main menu or Optimization > Data Selection > Multiple

 icon  in the tool bar. Then, you can select multiple regions on Multiple Region
the same plot as shown in .Figure: Multiple Region Selection

If you intend to choose a new region on another plot, the previous region is 
kept and no need to check .Multiple Region

Multiple Region Selection

Deselect Optimization Region

To deselect the optimization region on the current plot, right click the plot and 
select . To deselect the optimization region on all the plots, Deselect All Points
choose  from the main menu or Optimization > Data Selection > Clear All Pages

click  icon  in the tool bar.Clear All Pages

Make sure to clear previously selected regions before selecting new region. If 
any unexpected regions are included, the result of automatic optimization may 
be far beyond expectation.

Optimization Curve Selection

By default, all the curves within the selected region is included in the auto 
optimization. However, in some cases, only some curves are fitting targets. For 
example, to optimize MOS parameter VTH0 at initial steps, modeling engineer may 
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be only interested in the fitting results of linear gummel curve at Vbs=0. For that 
purpose, double-click those non-zero Vbs values( , ,  and ). -0.375 -0.75 -1.125 -1.5
Then the corresponding curves turn grey and the points is excluded in the auto 
optimization, as shown in following figure. Double-click again to restore these 
curves to the initial status.

Select single curve for VTH0 optimization

Running Optimization

After selecting the region and the curves to optimize, you can click  icon Optimize

 in the parameter window to start the auto optimization. After a while, you can 
see the results of optimization.

Selection of proper parameters for the optimization region and setting proper 
parameter values and boundaries is necessary, otherwise the results might be 
bad. Besides auto optimization, you can also perform optimization manually as 
mentioned in the previous section.

The optimization procedure is to minimize the RMS of the selected data points. 
Thus, RMS settings affect the final optimization results. As shown in Figure: 

, all the capacitance values are less than Influence of RMS settings on optimization
3E-11. If the resolution of RMS is set as 1.0E-9, zero RMS all over the plot is 
displayed. Under such situation, even if you perform the optimization with its 
optimizer, nothing happens.

During optimization, parameter value does not exceed boundaries.
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Influence of RMS settings on optimization

Running Optimization

After selecting the region and the curves to optimize, you can click  icon Optimize

 in the parameter window to start the auto optimization. After a while, you can 
see the results of optimization. Note: Selection of proper parameters for the 
optimization region and setting proper parameter values and boundaries is 
necessary, otherwise the results might be bad. Besides auto optimization, you can 
also perform optimization manually as mentioned in the previous section.

Checking points fitting error

You can check the error between the measurement and simulation for different 

points. To realize this, click the  icon  in the tool bar. Then Pin a Data Reader
click the data point interested, the difference value is displayed on the graph in real 
time, as shown in following figure. To clear one pin, click the corresponding data 
point again. If you want to clear all the pins, right-click on the graph and choose 

.Clear all pins

Adding pins to the points in one graph
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In the example above, this difference is expressed as  (Measurement data M-S
minus simulation value). MBP provides three expressions ( , , Show RMS Show M-S
and ) to choose from. Choose * Tool > Preferences* from the Show RMS and M-S
main menu, then click , the window is shown as following figure.Pinner Options

Pinner options

Optimization Summary

After the optimization, you can review the summary by choosing Optimization > 
 from the main menu, as shown in following figure. You can find the Summary

change of the error and the selected parameters before and after the optimization.

Optimization summary

Optimization Utilities and Options

MBP also provides options and some handy features when running optimization.

Choose Optimizer
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MBP provides different optimizers to choose from. Click Optimization > Choose 
 from the main menu, the window pops up as shown in following figure. Optimizer

The default optimizer is . You can choose other optimizer (such as GA, condor
PSO...) from the drop-down list.

Choose optimizer

Optimization Options

Step and Boundary Settings: Click Extraction > Options > Optimization 
 from the main menu to pop up the Optimization Options window as Options

shown in . Set the default step to Figure: Optimization options One Order 
 or . For example, let's suppose vth0 is 0.7V. Then, Lower Two Order Lower

after loading the model, for one order lower, the step is 1E-2 V; for two 
order lower, the step is 1E-3 V.

Checking  disables above two options. Then by default, the step is Auto Step Tune
always 1/20 of its boundary length (boundary length is defined as the difference 
between upper boundary and lower boundary.).

To use mouse wheel, determine the step in . You can set the Mouse Wheel Divider
percentage of the whole boundary difference. On rolling the mouse wheel, the 
parameter value changes accordingly.For example, if its boundary is [0,100], the 
value here is set to 20 (percent). So, every time you roll the wheel, the value 
increases/decreases by 20. And once the cursor reaches upper or lower boundary, 
you can enable automatic boundary expansion by continuous rolling, if the box* 
Shift boundary when adjusting boundary with mouse wheel* is checked.

You can either expand the boundary on both directions (by checking the Bi-
 box) or make the optimizer to expand intelligently (by checking the direction

 box). For example, if the value is in the upper 30% of the boundary Intellectual
range, the upper boundary is expanded. The lower one is expanded if it is in the 
lower 30%. And if the value meets both requirements, both boundaries are 
expanded.
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Load & reset is for soft boundary control. Once a model is loaded into MBP, MBP 
sets parameter soft boundary according to the digit input in the . For Init ratio
example, if you specify 50.0(%), then soft boundary is +/-50.0% of its absolute 
value. Besides, this setting is applicable to  Reset parameter boundary and step

icon  in the optimization window.

Optimization options

Optimizer Boundary Setting: When using its internal optimizer for tuning, 
any parameter is not allowed to exceed its soft boundary. However, MBP 
allows to auto expansion of the soft boundary during this procedure. To 
realize it, first check  box, then input the percent and Enable auto expansion
the times for expansion. To date, soft boundary is always within the range of 
hard boundary.

Other Settings
By checking , you can observe the simulation Update Plot While Optimizing
plots changing with the parameters during the whole optimization process. 
By default, the  option is checked to enable the hard Hard Boundary Enabled
boundary during the optimization. You can cancel the limitation by uncheck 
it.
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Weight Setting

MBP also allows you to set different weights for different devices when running the 
optimization. The  here means the part's weight in the whole integration. For weight
example, the default weight for every device in MBP is . So the RMS values of all 1
devices are multiplied by 1 (remaining unchanged). Since the build-in optimizer 
implements optimization according to the RMS value, it treats all devices the same 
opportunity. However, if you set the weight of one device as , the RMS value of 2
this device is multiplied by 2. Thus, optimizer treats it much more important than 
other ordinary devices with weight of .1

To use this feature, click  from the main menu. The Extraction > Weight Setting
setting dialog pops up as shown in following figure.

Weight setting

You can refer to the application note  for more details.Optimization Weight Setting

Spice Options

MBP supports simulation option of ,  and  as shown in GminDc Scale GeoShrink
.  is a conductance that is placed in parallel with all pn Figure: Spice options GminDc

junctions and all MOSFET nodes for DC analysis.  is element value multiplier. Scale
And  is geometry shrink factor as a global model to apply to all elements. GeoShrink
Check  option to enable  as the option.TempAsOption Temp

You can also append simulator compatible options into MBP, even those options 
are not supported by its internal engine. For instance, if you want to put .options 

 to external HSPICE. Type  to the line under User Option(s) EXPLI=1e-4 EXPLI=1e-4
and press  button. To keep netlist generated by MBP for external simulator, OK
choose  and uncheck  Simulation > External SPICE Options Is Delete Netlist Files
box.
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Check the  option if the original model file is used directly when isUserOriginalFile
calling external SPICE. You can input the model name (including the path) or some 
options and global parameters in the blanket below.

Spice options

Set Default

Clicking  to set all model parameters, except process Model > Set default
parameters, to default value. And this function is only valid to MOS models 
(BSIM3v3, BSIM4, BSIMPD and etc).

Reload Hard Boundary

The hard boundary can be reloaded by clicking  Model > Reload Hard Boundary
from the main menu. See  for the details about the model setting files MBP Files
which define the default value and the hard boundary.

Undo and Redo

This feature allows you to undo or redo the optimization operations. The two block 
arrows on the upper right corner of the parameter window are for this purpose. As 
shown below in following figure, the left one is for Undo and the right one is for 
Redo operation.
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Undo and Redo

You can also click and hold the button to activate the window as shown in following 
figure. It records the operation history up to 100 steps. You can choose to undo
/redo multiple operations at one time.

Undo multiple operations

Mark Model Function

MBP provides another method to switch between different models without saving 
(loading) model files to (from) hard disk.

When tuning model, you can mark current model by clicking the  icon  . Mark
The mark label  would be assigned to the old model and the label jumps to . 1 2
During subsequent tuning process, you can also mark other models in a similar 
method and switch between marked models at any time by clicking the left/right 
arrow buttons, as shown in following figure.

Mark and switch the model
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To clear all the marks, right-click on the mark label and choose , shown Clear Marks
in following figure.

Clear marks

Marked models are saved to RAM instead of hard disk. To create/load a new 
project or exit MBP loses all its information about the marked models.

Minimize the parameter window during optimization

In  optimization window mode, double-click on the  title bar to floating Optimization
minimize the window. The minimized parameter window is shown in following 
figure. You can restore the parameter window by the same operation.

Minimized Parameter Window

In  optimization window mode, you can minimize the window by clicking the fixed

 icon  . In the minimized window, click the  icon  to restore the Hide Show
normal view. As shown in following figure, you can perform search, optimize, mark, 
and undo/redo function in the minimized window.

Minimized fixed mode optimization window
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Data Display

Data generated after simulation and measurement can be viewed using plots, 
tables, graphics or text files, and other options like Data Reader.

Data Reader

Layout Configuration

Pin Function

Plot Details

Plot Operations and Options

Window Setting

Data Reader

To determine the XY coordinates of a data point on a plot, click the  Data Reader

icon  on the toolbar. This action opens the Data Display window. A red circle 
auto-tracks the nearest data point. The displayed value is for measurement Y value, 
Simulation Y value, P value and X value, respectively. Also, by holding the  key Alt
and dragging the cursor, you can find the slope between two points for both 
measurement and simulation. See following figure for an example.

Data reader function

Layout Configuration

Using Layout tools, you can configure the way device pages are displayed.

By selecting  as shown in following figure, you can configure how Tool > Layout
device pages are displayed. For example, if you want to view more plots, select 2x3, 
3x3 or more from Graph Panel Layout. Layout Config is often referred together with 
Device Navigator. For more information, see .Device Navigation
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Graph selection window

RMS Options

Root Mean Square error calculation is a popular method of assessing the fitting 
between the simulation and measurement. The RMS function used in MBP is listed 
below:

Im stands for measurement value and Is stands for simulation value. There are two 
RMS options, resolution and cutoff. Resolution stands for the minimum values that 
are included for RMS calculation, in other words, all the points below resolution are 
excluded from RMS calculation. Cutoff is the threshold that for RMS calculation 
below Cutoff, the RMS function becomes the following:

The value set in Cutoff should be surely larger than that in Resolution, otherwise it 
does not take any actual effect. MBP also provides another RMS method 
corresponding to "MAX Y" in RMS options, it uses the following equation:
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Imax is the maximum measurement value on the plot. To set RMS options, click 
 from the main menu, the RMS setting window pops up as Tool > GUI Option > RMS

shown in following figure. Set the values for resolution and cutoff. If you want to 
make RMS invisible on the plot, just check the option of .Hide RMS and MAX

RMS setting window

Pin Function

The button  in the main manual is used for Pin the value of the points in the 
plot, When user save the project the Pin information will be saved also.

Pin function

Use can drag the pin on GUI and right-click to switch or delete pin information
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User can customized pin contents and simple math expression(Tool – Preferences 
)– Graph View Options – Pin options

User is enabled to define Pin display order and content

Support advanced definition with simple math expression

Pin display style can show/hide border

Can preview pin display style

User can export and Import Pin configuration file
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Plot Details

Plot option window

The scale options are defined in following table.

Table: Scale options

  Mode Default Settings

Min X By value Minimum X

Max X(%) By scaling 100% of maximum X

Min Y By value Minimum Y

Max Y(%) By scaling 100% of maximum Y
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By value: To specify a digit value
: To set the size a percentage of the maximum measured or simulated By scaling

data points

You can also define line width(default is 1.0), display precision(default is 3) and 
Symbol Size(default is 4) in this window.

View

View option

Plot Operations and Options

MBP is quite flexible on plotting. You can zoom in/out on the plot, set data range, 
change scale, apply math functions on the existing plots and export plots as 
pictures. The features are described as follows.

Zoom In & Zoom Out

To zoom in, select the region to be zoomed by using cursor (left-click and hold). To 
return to the original scale, double-click or right-click the plot and select Back to 

.Original

Eagle eye

If this option is checked (right-click on the plot to show ), once Enable Eagle Eye
you perform  on a page, one small window automatically pops up at the zoom in
right bottom corner of current page, as shown in following figure. The pop-up 
window shows the full image of original page. And the red rectangle selected 
region has been zoomed in. You can also drag and resize the red rectangle to focus 
on whatever region for zooming in.
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Zoom in with eagle eye option

Repaint

To refresh the plot.

Set Data Range

Right-click the plot and select . Uncheck  Data Range Settings Default Data Range
and the  option for certain scale options. Enter boundary value you want Set Default
to view with, as shown in following figure. User-defined range could be either 
within or out of real data range. Each Math Transform (to be introduced later in the 
section) has its own data range. For instance, if you have defined a range on the 
plot with  math function, then on applying  to the plot, this data range set y dx/dy

does not take effect, unless returning to . However, user-defined data range is y

kept with scale change. In addition, you can apply this data range to all plots that 
with the same page index in current project by checking the option of Map The 

.Data Range
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Data range settings window

Change Scale

Right-click the plot and select , you have an option of linear and log Linear/Log
scale for both X and Y axis. You can also double-click the values of X (or Y) axis to 
switch the linear and log scale of the axis.

View Data as Table

Right-click the plot and select , the table that contains both View Data As Table
measurement and simulation data points pops up. The error between measurement 
and simulation is also attached behind, as shown in following figure.

Sample data table
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Once you apply math function like  on plot, MBP prints out transformed data dx/dy

in the table. However, data shown in an opened table refreshes automatically with 
the tuning model parameters. Close the current and open a new one to see the 
change.

Save Plot as Graphic or Text Files

Right-click on the plot and select , you can either save it as a graph (gif) or Save as
text file.

Math Transform

MBP allows you to apply math functions to the plot including plotting y (by default), 
1/y, y', y'', y''', dx/dy, etc. Right-click on the plot and select , then Math Transform
choose the math equations you want to apply. The following figure shows an 
example of plot after  transform.y'

y Math transform with x-lin, y-log scale

In addition to existing math transform functions, you can also customize math 
transform functions with some simple programming. Right-click on the plot and 
select , the Math Transform Manager window pops up Math Transform > Customize
as shown in following figure. Right-clicking the plot next time, the appended math 
function is also in the  list.Math Transform
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Math transform manager

Measured Line

You may like to view measurement data only under certain circumstance such as 
checking the measurement. By checking , the plot only shows Measured line
measurement data, in line plus symbol style, shown in following figure.

Example plot with measured line checked
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Extend Simulation

You can also observe the simulation result without the limitation of measurement 
data. Currently, MBP supports both X axis and P axis direction extension. The 
setting and result windows are shown in  and Figure: Extend simulation window

, respectively.Figure: Extend simulation result

Extend simulation window

Extend simulation result

Besides IV curves, Extend Simulation also allows you to deal with IMV plots as 
shown in following figure. You can extend simulation points out of measured points 
or between measurement points.
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Extend simulation result on IMV pages

Window Setting

This option allows you to arrange the plot panel either in  or  mode as Tile Cascade
below shown in  and Figure: Plot panel in tile mode Figure: Plot panel in cascade 

.mode

Plot panel in tile mode
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Plot panel in cascade mode
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